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Introduction

1.1 Supervision reports
Reports are an important part of the Cambridge supervisions system. As well as giving
you feedback on your own progress, supervisors’ reports are necessary for your College
to check that you are being adequately supervised, and to allow your Director of Studies
or Tutor to help you with any problems you have with your course.
Technically, supervision reports are known as formative assessments. Your supervisors are not providing final (summative) judgement on your performance; that is done
through formal examination. Rather, they provide views and reactions which are intended to help you develop as a student.
CamCORS, Cambridge Colleges’ Online Reports for Supervisions, is a system that
allows supervision reports to be read, written, and processed online. Supervisors are
asked to create report forms for each of their students at the beginning of term, and to
write them up as soon as practical after each supervision1 , and submit them to Colleges
on the completion of supervisions for the term. CamCORS makes it possible for students
to view all supervision reports written about them by any supervisor during their time
at Cambridge, to print them out and to save them to disk.
In order to use CamCORS, you will need
a computer with Internet access, and
a web browser which supports tables and secure connections over SSL. (Modern
browsers routinely support secure connections; a reasonably recent Windows,
Linux or Macintosh machine should come with an appropriate browser2 .)
The checklist for Cambridge-specific permissions you will need is as follows (the jargon
is explained in the next section of this manual):
• Get a CRSid
• Get a Raven password
• Make sure your @cam.ac.uk email address works3
• Get your CamCORS roles enabled
You do not have to be within Cambridge, or have a computer in the cam.ac.uk domain, to use CamCORS—it may be accessed with safety from anywhere on the Internet.
1 so

that the memory is still fresh, and so that tutorial problems may be spotted promptly.
makes light use of Javascript, and it will operate if Javascript is unavailable.
3 if you have any role other than supervisor
2 CamCORS
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1.2 Usage notes
Although CamCORS is in place throughout the University, it is up to individual Colleges
to decide exactly how it is to be used. In particular, students may be permitted to read
their reports immediately the supervisor has submitted them, or they may have to wait
for their release by Tutors, Directors of Studies or Senior Tutors. Some colleges may
choose not to allow students to read their reports online at all.
You should note that once you have left Cambridge at the end of your course your
account will be disabled and you will no longer be able to access your reports directly
through CamCORS yourself. You are therefore advised to print them out or save them
to disk at the end of your last term.
CamCORS is provided so that you can read supervision reports to which you have
legitimate access. You are reminded that attempting to use CamCORS for any other
purpose is contrary to the Rules made by the Information Technology Syndicate
(http://www.cam.ac.uk/cs/itsyndicate/rules.html) and may also be a criminal offence.
All activity of users on the CamCORS system is logged, and offences will be reported to
the appropriate authorities.
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CamCORS users

2.1 Your account on CamCORS
Your College will have already set up an account for you on the system. The
account name is your CRSid, which is a unique username assigned to you by the
Computing Service. In your Cambridge e-mail address (ending in @cam.ac.uk or
@hermes.cam.ac.uk,) the portion preceding the @ is your CRSid.
Any e-mail sent through CamCORS to you will be sent to the address
crsid@cam.ac.uk. If you prefer to use a different address as your primary e-mail
address, you should set Hermes1 up to forward all mail sent to crsid@cam.ac.uk
to your usual account.
See the Computing Service’s leaflet IS12 (available at
http://www.cam.ac.uk/cs/docs/infosheets/is12/) for details of how to set up mail
forwarding.

2.2 Logging in
CamCORS’ home page is located at http://www.camcors.cam.ac.uk/. This page is used
by the administrators of CamCORS to bring important information to your attention (e.g.
concerning service interruptions owing to maintenance). We recommend that you bookmark this page, rather than the log-in page, or at least consult it regularly. The home page
also contains convenient links to the on-line version of this manual, and to the CamCORS
FAQs (Frequently Asked Questions.) The CamCORS log-in page can be accessed through
the ‘login’ link from the home page, or directly at https://camcors.cam.ac.uk/camcors/
(note https.)
When you attempt to log in to CamCORS, CamCORS checks whether you are logged
into Raven (without which, CamCORS cannot identify which particular person you are).
If you are not logged into Raven, you will first be diverted to Raven and requested to log
in.
If you are logged into Raven properly, then CamCORS will ask you which role you
wish to adopt; if you have only one role within CamCORS (e.g., you are a student), this
screen will automatically pass by, but it may be visible for a split-second.
Once a role has been selected (by clicking or automatically), CamCORS will display
its Main screen.

The main menu
Each role within CamCORS has a main menu. You can reach the main menu of another
role you possess by selecting Change role.
The options available to you on the main menu are as follows:
1 or

whichever mail system receives your @cam.ac.uk email
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View supervision reports Choose this option to search for and read or print out reports
that have been written about you (Section 3.1.)
Change role Exercise a different role.
Log out of CamCORS Use this option to end your session with CamCORS (Section 2.3.)

2.3 Logging out
Remember to log out when you have finished, especially if you are using a machine to
which others have access. Note that you should log out of Raven as well as CamCORS.
You may log out either using the Log out of CamCORS option on the main menu, or
by clicking on the Log out link at the top right of most pages.

Automatic logout
If you have worked on a single page for more than 90 minutes without performing any
action which communicates with the server, you may find that you have been automatically logged out when you do try to perform the next action (e.g. running a new search,
or sorting the displayed reports.) You will see a different login page from the one which
appears at the start of a new session. CamCORS keeps track of what you were trying to
do, so that after you log back in you will be taken directly to the relevant confirmation
page so that you can carry out the action you wanted to perform.
It may occur that you decide to log out after a long break. In this case, because your
session will have expired, CamCORS will present you with a login screen, because it
needs you to log in before it knows you are entitled to log yourself out. At this point,
you need not log in again if you do not want to.

2.4 Privacy
The Colleges sought legal advice on privacy issues before setting up CamCORS, and you
will have signed on matriculation an agreement that the College may process personal
information about you, sufficient to cover the uses made of your data by CamCORS.
The two principal pieces of privacy-sensitive information that CamCORS holds about
you are your supervision reports and your photograph as supplied by the University
Card system. Supervision reports may be made available by CamCORS to you, the supervisor who wrote them, your Director of Studies, your Senior Tutor and the pastoral
care officers within your College2 . The non-academic information contained within or
inferrable from supervision reports may be quite sensitive. It is not available to College
officials responsible for paying supervisors, who otherwise enjoy a high level of access
within CamCORS, or in the general case to Course Directors within Faculties.
Photographs of students on CamCORS greatly reduce the incidence of reports being
written about the wrong student. It is possible for your photograph to be removed from
2 Colleges vary as to how they handle pastoral care: at one end of the spectrum, Trinity and St John’s assign
each student a Tutor who looks after the non-academic side of their life within the College—such an officer
would ordinarily have access to supervision reports; at the other end, Jesus assigns the primary pastoral caregiver role to Directors of Studies
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CamCORS at your request. If for some reason you need this to happen, you should
contact your Senior Tutor. The removal can be made to take effect within a few working
hours.
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3 Viewing and processing
reports
To see the reports, click on View reports on the main menu. The ‘Report Search and
Selection’ page will be displayed.
This page contains a large search form; below it, a summary of your reports for the
current term (or, if during the vacation, for the term that has just ended); and, at the bottom, a panel of Actions you may perform on selected reports. (To choose which reports
to view from a summary list, you may use the ‘Report Search and Selection’ page.)
If there are no reports available to you in the current term, only the ‘Report Search’
section of the page is visible. You may search for other reports by altering the search
criteria (see below.)

3.1 Searching for reports
CamCORS stores every report that has been written about you since its inception, and
you may search through, read, and print these at any time (subject to the permission of
your College.)
To search through the available reports, enter into the appropriate boxes the information you know. Leave blank any field which you want to be able to vary. In the case
of the two date boxes and XRNLI number, anything which is not a valid date or XRNLI
number will be ignored. In the text boxes, you may also search for values beginning with
a certain string of letters or words.
The available fields are:
Supervisor Either the first name or the surname of the supervisor, or some letters from
the beginning of one or other of these names. For example, ‘Smith’ would find
reports written by Dr. Smithers as well as Ms Smith. Use surnames if possible,
since some first names have unusual contractions (searching for ‘Tony’ will not find
any Anthonys, nor ‘Peggy’, any Margarets.) Be careful also to distinguish names
beginning ‘Mac...’ from those entered as ’Mc...’.
If you are unsure about the spelling of a supervisor’s name, use the CRSid field
instead.
CRSid The CRSid of the supervisor.
You can find out CRSids from names
(including like-sounding names) using the University e-mail search at
http://www.cam.ac.uk/global/search/. Note that this database only contains the
CRSids of those who have consented to their details being made public. A
separate box is provided for searching through reports by CRSid.
Tripos The name of the Tripos Part for which the supervisions were given: choose one
from the drop-down list. Some browsers will allow you to type the first letter of
7

the required Tripos Part (H01 code) to jump to the relevant place in the list. If you
use a mouse wheel, be careful to remove the focus from the drop-down list after
you have selected a Tripos, since moving the wheel inadvertently will alter your
choice.
Tripos H01 code Letters from the beginning of the University’s internal (H01) code for
the Tripos. These codes are listed in the drop-down box above. For example, entering NST0 will search for reports in the Natural Sciences Tripos, Part 1A, whilst NST
will search for all Natural Sciences reports. You can search for reports by H01 code
or code prefix.
Paper title The
official
title
of
the
paper
(as
given
H03
University
Examination
and
Paper
Codes
http://www.admin.cam.ac.uk/offices/students/codes/h03.html.)

in
List

the
at

Topic The topic of the supervisions, as described by the supervisor. You can search for
reports by their topic, if you know the precise text of the description used.
Term The term, whether Michaelmas, Lent, or Easter. This field defaults to the current
term, or the term that has just ended. Other terms may be selected from the dropdown list.
Year The academic year. This field defaults to the current year. The ‘Year’ search criterion
refers to academic, rather than calendar, years.
Submitted The date the report was submitted. You may search for any date range by
entering two dates in the format dd/mm/yyyy. Leading zeros are expected, i.e.
03/09/1989 and not 3/9/89.
XRNLI The report’s unique code number. You can search for a single report using its
XRNLI number.
By default, your search results will be shown in batches of 100. If you need to vary
this setting, change the number in the ‘Up to... ...reports will be shown’ box beneath the
search form. Once you are happy with your search criteria, click ‘Search for Reports’ on
the right-hand side of the lowest grey bar to run your search.

3.2 Sorting and selecting retrieved reports
Once you have made a search, a table will be visible below the form listing all the reports
that matched your criteria. This table has six columns, initially in this order:
Supervisor The name and CRSid of the supervisor.
Subject A condensed description of the paper being taken.
Term The term for which the supervisions were given, in the form Xyyyy where yyyy is
the calendar year and X a single-letter abbreviation for the term (M for Michaelmas,
L for Lent and E for Easter.)

8

Hours If the report has been written and released for your viewing, this field contains
the number of hours of supervision which you were due to have for this course,
including hours missed and hours still to come.
Rel. ‘Yes’ if this report has been released by the appropriate College authority for you to
view; ‘No’ if it remains unreleased.
The table is automatically sorted by the first column, then the second, and so on. Each
of the column headings is a button allowing you to sort the table of search results to your
preference. If you click on one of these buttons, that column is moved to the leftmost
position, and the table is sorted accordingly.
For example, to obtain a table sorted first by subject and then by Term,
• Click on the Term button, to move the ‘Term’ column to the left and sort,
• Now click on the Subject button, to do the same to the ‘Subject’ column. The reports
are then sorted by subject, but reports with the same subject remain sorted by date.
CamCORS will remember the current sort order if you make a new search, or if you
perform other actions within CamCORS before returning to the Report Search and Selection page. Once you log out, this information is lost; next time you log in you will see
the columns in the default order given above.
To select reports for action, check or uncheck the boxes to the left of each table entry.
The buttons in the ‘Actions’ panel at the bottom of the page apply to the selected reports
only. For convenience, three additional buttons are provided at the bottom of the table:
Select All Checks all the boxes.
Deselect All Unchecks all the boxes.
Reverse Selection Checks all the currently unchecked boxes, and unchecks all the currently checked boxes.
These buttons reload the page, but do not alter which reports are displayed or how they
are sorted.

3.3 Viewing reports
Once you have made a selection, click View to display the full reports. This page does
not contain any search facilities. If you want to view a different selection of reports, you
should return to the ‘Report Search and Selection’ page using the Go back button at the
bottom. Each report on the page appears in either stub form or full form, usually the
former.

Stub reports
Stub reports are visible whenever a report has been created, but has not yet been released
for you to view. They contain basic administrative information common to all reports, as
well as providing some useful e-mail links (Section 3.5.) Available is
• (on the left side) your name, CRSid (with e-mail link) and College,
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• the Tripos for which the report is being written,
• the paper for which the report is being written, followed by the topic if applicable
(in brackets)
• ‘Supervised by’, followed by the supervisor’s name and CRSid (with e-mail link),
• the term and calendar year of the supervisions,
• (on the right side) a unique reference code for the report, beginning XRNLI-,
• an e-mail link to the College’s supervisions@college.cam.ac.uk address,
which should be used for any general enquiries relating to the report,
• an e-mail link to your Director(s) of Studies for this course, if applicable,
• an e-mail link to your Tutor(s) for this course, if applicable, and
• (on the far right) your photograph (if available.)

Full reports
Once a report is ready to be viewed, the stub report expands into its full form. At the
top of each full report is an information section, containing the same details and e-mail
links as the stub form of the report. Below it is the actual report, containing the following
information:
• (at top left) the supervisor’s general assessment of your
industry, (Good, Satisfactory, Unsatisfactory, Not specified)
progress, (Good, Satisfactory, Unsatisfactory, Not specified)
interest, (Enthusiastic, Interested, Could show more, Not specified), and
likely result for the examinations in this course.
• (at centre left) A table showing the number of hours of supervision (including supervisions missed and yet to come) in the bottom row, with the number of students
in the supervision group in the top row. These figures constitute your attendance
record in the event of any appeal or application you make to the University. If they
are incorrect, you should advise your Director of Studies of the error as soon as
possible.
• (at top right) The text of the supervision report.
• (below these) The phrase ‘The student may read this report’, indicating that it has
been permanently released for your records, together with the date the supervisor
submitted it to your College.
• (at bottom) A space for comments made by your College on this report. These
comments may be added by your Tutor(s), Director(s) of Studies, Senior Tutor, or
by the College Office. Each comment is tagged with the CRSid of the person who
made it.
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Full reports are not normally available to Course Directors.
The College may exclude reports from Course Director view (thereby overriding the
decision of the Senior Tutors’ Standing Committee on Education in respect of their own
students. This may be done through the Configure college-wide preferences option.
Course Directors are always informed which Colleges have done so.

3.4 Printing out reports
You may export your reports from CamCORS either in PDF (Portable Document Format,
suitable for printing or achiving on a server or CD-ROM), or as raw data which you can
later load into a spreadsheet or your own database. You will need to have a PDF viewer
installed when you come to print reports; Adobe Acrobat Reader is free and available
from http://www.adobe.com/products/acrobat/readstep2 .html.
To generate PDF report forms:
• Find and select the reports which you wish to export on the ‘Report Search and
Selection’ page (Section 3.1.)
• Click Display PDF on the ‘Actions’ panel. You will be prompted to display the
resulting file, or alternatively to save it. The PDF file contains two reports per A4
page, in a similar arrangement to that displayed online (Section 3.3.) The reports
appear in the same order as they appeared on the ‘Report Search and Selection’
page—i.e. taking account of any sorting you have performed (Section 3.2)—with
the first report being at the top of the first page, the second below it, and so on.
• Alternatively, click Display PDF for guillotine. This performs the same action, except that the second report is placed at the top of the second page, and so on, so
that the report placed at the bottom of the first page occurs halfway through the list
of reports. This ordering means that if you cut through the stack of A4 sheets and
then place the bottom page halves behind the top page halves, the resulting stack
of A5 sheets will be in the order you required. You can print out reports in a form
suitable for guillotining.
Once CamCORS has generated a PDF file, it will pass it to your browser. If you have
a PDF viewing program installed on your computer, your browser may ask you whether
you wish to open it now or save it for later; or it may ask you for a location on your local
computer where it can put the file.
If you are using Microsoft Internet Explorer to use CamCORS, you may see a message
asking whether you want to display ‘secure and insecure content’. Click Yes to load the
PDF document.
Once the PDF viewing program is running, it acts as a separate task. To print or
save the file, you should use the facilities that program provides. If you wish, you can
continue working in CamCORS whilst the PDF viewer is open. Click Back to report
summaries in your browser window to continue working in CamCORS. PDF files are
displayed in their own window; where browsers such as Internet Explorer attempt to
suppress advertising-style pop-up windows, users may need to right-click rather than
left-click to access the PDF file.
If you would rather obtain the report data in a form suitable for processing, you
should use the Export data facility. See section 4.2 for more details.
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3.5 Sending e-mail
CamCORS provides two convenient ways of sending e-mails to the students, supervisors, Directors of Studies and Tutors associated with a report or selection of reports.
E-mail links are quick and handy, but require you to have an e-mail program installed
and configured on the machine you are using. Web-based e-mail is provided within
CamCORS, and is more flexible if a little less convenient.
Most of the e-mail addresses held in CamCORS are personal addresses
held by the addressee only.
The exception is the special address
supervisions@college.cam.ac.uk, which is guaranteed to exist for all colleges.
When you e-mail supervisions@ college.cam.ac.uk, or use the links or form
described below, your e-mail will typically go to someone in the Tutorial Office who can
redirect it as necessary. You should therefore use a clear, generic header (e.g. “Tutorial
problem”, “Query concerning ...”, etc.) to enable the recipient to pass on your query, if
necessary, quickly and efficiently.
You should remember that an e-mail is basically an electronic postcard, and that it
is not good practice to use e-mail for very confidential or sensitive comments. Much of
what is recorded in CamCORS or in email might form the subject matter of a Data Protection Act subject access request, and therefore the question is not whether the student
can see it but how much effort must be expended in doing so. Supervisors who wish
to make comments about a student which they would not wish to be disclosed to the
student are advised to do so over the ’phone rather than via email or CamCORS.

E-mail links
To send an e-mail to people associated with a single report, first view the report as described above (Section 3.3.) Every report has five links at the top, which allows email to
be composed and sent, using your own email programme, to any one of
• you
• your supervisor,
• the College’s supervisions@college.cam.ac.uk address,
• your Director(s) of Studies, or
• your Tutors.
(Directors of Studies and Tutors are assumed to have e-mail addresses of the form
crsid@cam.ac.uk.)
If you wish to send e-mail to people associated with more than one report, find and
select a group of reports from the ‘Report Search and Selection’ page (Section 3.1), and
click Email on the ‘Actions’ panel at the bottom. Thus, to send an e-mail to all of your
supervisors (e.g. in case of illness,) you would run a search for all relevant reports and
click Email.
Below the form on the next page are five links, which work in the same way as those
on the report form for the combination of all the reports you selected. Beside each link is
a list of the e-mail addresses to which your message will be sent. (In the above example,
you would click on the Supervisors link.) Clicking on any of these links will launch the
12

e-mail program you have configured in your browser, if any, and will send e-mail from
whatever address is configured into that program.

Web-based e-mail
CamCORS also has a web-based e-mail facility that you may use if
• you prefer not to install an e-mail client,
• you are using a public machine, or any machine that is not configured for you, or
• you wish to send e-mail to more than one of the above categories of people simultaneously,
To use this feature, find and select a report or group of reports from the ‘Report Search
and Selection’ page (Section 3.1), and click Email on the ‘Actions’ panel at the bottom.
Check the boxes corresponding to the people to whom you wish the message to be sent,
type the text of the message into the box and click Send email. CamCORS supports the
use of Blind Carbon Copy, which permits a recipient’s existence to be concealed from
other recipients of a message.
E-mails sent from this form will appear as if sent from your own crsid@cam.ac.uk
account. You should ensure that replies sent to this address can reach you.
You can send e-mails directly from CamCORS to people associated with a report or
group of reports.

3.6 Notification of reports
Directors of Studies and Tutors may request that they be emailed notification of newly
submitted reports. Neither the Senior Tutor nor the College Office knows if the Director
of Studies or Tutor has activated this facility1 .
Your supervision reports may be read by your Director of Studies, Tutor2 and Senior Tutor. Non-attendance or poor performance at supervisions is often an early warning sign for the College that you are experiencing difficulties of a non-academic nature,
which it may be important for your Tutor to know about (or indeed that you are slacking
off, which your Director of Studies might want to know about too).

1 this may be relevant when they attempt to word communications with supervisors inquiring as to why
they have not been paid
2 or person in equivalent position, e.g., a Tutorial Advisor
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4

Working with data files

4.1 CSV data files
All data files for CamCORS are in CSV format, with comma-separated fields and
newline-separated records (i.e. one row per record.) CSV files can be created using a
variety of programs, most simply using a basic text editor such as Notepad. Microsoft
Excel also has some facilities for editing CSV format.

Working safely with CSV files
CSV files are flexible and portable, but there are some issues with them, in particular involving Excel. If you intend to use Excel to edit CSV files, you should read the following
sections with care.
By default, Windows hides file extensions for types it thinks it knows about, including
CSV. This can cause some confusion, since the icons for different file types are similar. In
order that you can more clearly distinguish CSV files from true Excel files (.xls) or text
files (.txt) we recommend that you ensure Windows displays the extension to the file
name by the following method:
• Open the folder in which you keep your CamCORS files.
• Go to the Tools menu and select Folder Options....
• Select the View tab.
• Make sure that ‘Hide file extensions for known file types’ is not ticked.
• Click OK.
Using CSV files in text editors
In many circumstances you may only wish to check an entry, rather than undertake any
serious editing of the data. On these occasions, you may find it easiest to open the file
in Notepad. If you have not changed the default application for opening CSV files to
Notepad (as above), this may be performed as follows:
• Open Notepad (often found in Start→Programs→Accessories.)
• Open the File menu, and click Open....
• Change ‘Text Files’ to ‘All Files’ and locate the file you wish to open.
• Use Find... or Replace... from the Edit menu to search the file.
• If you wish to keep a copy of the file which opens with Notepad by default, give it
a different filename when saving, for example by adding .txt to the end. If you
do not do this (and Excel still ‘owns’ CSV files), double-clicking on the saved file
will load it into Excel.
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Working with Excel
Excel is easy to work with, but highly idiosyncratic. If installed on your system, it will
give CSV files an icon similar to its own, but with ‘a,’ in the file box. Double-clicking on
the file will import it into Excel using the default settings. However, these are not suitable
for working with CamCORS’ CSV files. In particular, CRSids often take the form of three
letters followed by two numbers. If Excel spots a field whose letters spell ’JAN’, ’FEB’,
’MAR’, etc., it will by default interpret it as a date: thus the valid CRSid, dec25, would
be silently converted into Dec-25 wherever it occurs.
If CSV files are associated with Excel in Windows, double-clicking on them will always cause these problems, no matter how many times you have previously altered the
settings.
A global solution is to make a simple text editor, rather than Excel, the default program with which to open these files. If the only CSV files you handle are those connected
with CamCORS, this is likely to be your best option.
• Select any CSV file (an Excel icon with ‘a,’ in the box.)
• Right-click and select Properties.
• Next to the text reading ‘Opens with Microsoft Excel’, click on the button marked
Change....
• From the resulting list select Notepad, either by scrolling down or by pressing n
repeatedly.
• Click OK.
• You are returned to the Properties window. Again click OK.
Notepad is now the default application for viewing and editing CSV files, and their
icons will change to reflect this. Notepad does not alter any file when it is loaded, so
double-clicking them will now be safe.
Loading CSV files into Excel (Office 2000)
It is possible to work safely with CSV files in Excel by using its import function. However,
Excel must already be running for you to take advantage of this. To import a CSV file
safely:
• Create a blank new worksheet.
• On the Data menu, select Get external data.
• Choose Import text file.
• Change the ‘Files of type...’ entry from ‘Text Files’ to ‘All Files’
• Find and select the file you wish to ‘import’ (i.e. open.) Make sure you choose the
CSV file and not a .xls or .txt file of the same name.
• Click Import.
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• A wizard will pop up, defining your file as ‘delimited’ and displaying some sample
entries. Click Next.
• Check the ‘commas’ box, and uncheck everything else. Click Next.
• You will see some sample data. Highlight all columns by clicking in the first, holding down SHIFT, and clicking in the last.
• Click on Text in the Formatting Options pane.
• Click Finish.
• Click OK in the next window.
You now have data in a form you can manipulate, and on a sheet that will not convert
CRSids to dates nor drop leading zeros.
If you have a different version of Excel to the one described here, ask your Computer
Officer how to import CSV files as text.
Saving CSV files from Excel
Excel is very reluctant to let one save files in any format other than its own .xls type.
CamCORS cannot import Excel files, the format of which is proprietary, subject to
change, and costly to license. Instead, you must ensure that everything is saved as CSV,
resisting the insistent pressure from Excel to save them in its own format.

4.2 Exporting supervision report data
You may export data on supervision reports held on CamCORS to your local computer.
This may be useful if, for example, you want to create an e-mail list of all your supervisors, or simply want to view CamCORS data in your own spreadsheet or database
package. You may export CamCORS data directly onto your own computer.
To export data:
• Choose View reports from the main menu.
• Use the search and selection facilities to identify the reports you are interested in.
(See Section 3.3 for more details.)
• From the ‘Actions’ section at the bottom of the ‘Report Search and Selection’ page,
click on Export data.
• A page appears detailing all the information CamCORS holds about reports. Select
the fields you want to be exported.
• The file exported is in CSV format, with one supervision report per line. If there
are already new line characters in any of the fields exported (most commonly, the
report text), they must be replaced. The default is to replace them with the code \n.
If you want a different replacement, enter it into the small box at the bottom of the
form.
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• Click Export selected fields, and save the file you are offered onto your hard disk
(or open it directly into your favourite application.) By default, the name of this file
takes the form camcors report data yyyymmdd.csv, where yyyymmdd represents today’s date.
The exported file contains a fixed number of fields, depending on which were chosen
on the export page. Its first line contains headings explaining the content of each column.
The leftmost column, ‘Repeat’, is the number of reports which share the same values for
all the data you requested to be exported.
If you attempt to export any fields whose contents you are not authorized to view,
the entry in each line for that field will be exported as the string HIDDEN.
If you want to insist on having a single line for each report, for example for preparing
statistics in a spreadsheet, you should tell CamCORS to export the XRNLI code in addition to the data you require. Since the XRNLI code is unique to each report, no two lines
in the exported file will be identical.
To return to CamCORS from the ‘Export data’ page, click on Main menu at the top of
the page.
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